
Teacher Guide

Lessons for Elementary Students: Grades 3-6 

Technology Course using 

Excel & Word
Formulate a plan to boost sales. 

In this course, students develop a plan to boost candy sales. They investigate a problem by 

conducting a survey and researching candy packaging. A spreadsheet is used to organize, 

calculate, and graph data. Based on the evidence students recommend a solution in a 

written report. Extension activities challenge students to explore formulas, learn advanced 

graphing techniques, or design a candy package. 

Copyright © 1993 – 2024 TechnoKids Inc. 

All Rights Reserved 

This is a preview. The number of pages is limited. Some pages are omitted. 

TechnoCandy is available for Google and Microsoft. 

https://www.technokids.com/store/elementary-school/technocandy/spreadsheet-lessons.aspx 



Contents 

Copyright © TechnoKids Inc. TechnoCandy | Microsoft 365 

Table of Contents 

Introduction

Introduction ............................................................................................................................................. i

TechnoCandy Overview ....................................................................................................................... ii

TechnoCandy Course Outline ............................................................................................................. iii

Technology Integration Ideas ............................................................................................................. iv

Session 1 About Microsoft Excel

Session 1 About Microsoft Excel ........................................................................................................... 1

Assignment 1 Spreadsheets and You .................................................................................................. 2

What Is a Spreadsheet?................................................................................................................... 2

Why Use a Spreadsheet? ................................................................................................................ 2

Assignment 2 Explore Spreadsheets .................................................................................................... 3

Open Excel ........................................................................................................................................ 3

Save a Workbook ............................................................................................................................. 3

Discover Columns ............................................................................................................................. 3

Explore Rows ..................................................................................................................................... 4

Understand Cell Names ................................................................................................................... 4

Add Data into a Cell ........................................................................................................................ 5

Move from Cell to Cell ..................................................................................................................... 5

Select a Range of Cells ................................................................................................................... 6

Be a Spreadsheet Detective ........................................................................................................... 6

Save and Exit Excel .......................................................................................................................... 6

Assignment 3 Play Spreadsheet Bingo ................................................................................................ 7

Session 1 Extension Activity: Have Fun with Cell References ............................................................ 9

Session 2 Conduct a Color Survey

Session 2 Conduct a Color Survey ..................................................................................................... 10

Assignment 4 Understand the Problem ............................................................................................ 11

What Is the Problem? ..................................................................................................................... 11

Make a Plan to Solve the Problem ............................................................................................... 11

Assignment 5 Conduct a Survey ....................................................................................................... 12

Assignment 6 Record Survey Results in a Spreadsheet ................................................................... 13

Open Excel ...................................................................................................................................... 13

Add the Sheet Title ......................................................................................................................... 13

Organize Survey Results ................................................................................................................. 13

Merge Cells for the Survey Title ..................................................................................................... 14

Format the Appearance of the Title ............................................................................................ 14

Change the Font Color and Fill a Cell ......................................................................................... 14

Align the Title ................................................................................................................................... 14

Adjust Row Height and Align Vertically ....................................................................................... 14

Outline the Table with Borders ...................................................................................................... 15

Resize Column Width ..................................................................................................................... 15

Use Skills to Format the Survey Data ............................................................................................. 15

Save a Workbook and Exit Excel .................................................................................................. 15

Assignment 7 Calculate Survey Data ............................................................................................... 16

Open the Candy Workbook in Excel ........................................................................................... 16

Calculate the Number of People Surveyed ............................................................................... 16

Save and Exit Excel ........................................................................................................................ 16

Session 2 Extension Activity: Experiment with Sum ........................................................................... 17



Contents 

Copyright © TechnoKids Inc. TechnoCandy | Microsoft 365 

Session 3 Graph the Color Survey

Session 3 Graph the Color Survey ...................................................................................................... 18

Assignment 8 Graph the Survey Results ............................................................................................ 19

Open Candy Workbook in Excel .................................................................................................. 19

Create a Column Chart ................................................................................................................ 19

Move and Resize the Graph ......................................................................................................... 19

Edit the Graph Title ......................................................................................................................... 20

Apply a Chart Style ........................................................................................................................ 20

Fill a Bar with Color ......................................................................................................................... 20

Fill the Plot Area .............................................................................................................................. 20

What Do Your Survey Results Mean? ........................................................................................... 21

Adjust Text Wrap and Format the Text ......................................................................................... 21

Print the Worksheet ........................................................................................................................ 21

Save and Exit Excel ........................................................................................................................ 21

Session 3 Extension Activity: Explore Chart Types ............................................................................ 22

Session 4 Research Candy Packaging

Session 4 Research Candy Packaging ............................................................................................. 23

Assignment 9 Research the Candy ................................................................................................... 24

Assignment 10 Record Research Results .......................................................................................... 25

Open Candy Workbook in Excel .................................................................................................. 25

Add a New Sheet Tab ................................................................................................................... 25

Add a Title to the Sheet ................................................................................................................. 25

Organize Research Results ............................................................................................................ 25

How Many Candies Are in Each Package? ............................................................................... 26

Insert a Picture onto the Worksheet ............................................................................................. 26

Session 5 Graph Packaging Results

Session 5 Graph Packaging Results ................................................................................................... 27

Assignment 11 Make a Comparison Chart ...................................................................................... 28

Open Candy Workbook and View Research Sheet in Excel .................................................... 28

Sort the Data ................................................................................................................................... 28

Create a Comparison Chart ......................................................................................................... 29

Edit the Graph Title ......................................................................................................................... 29

Change the Position of the Legend ............................................................................................. 29

Add Horizontal and Vertical Axis Titles ......................................................................................... 30

What Do Your Research Results Mean? ...................................................................................... 30

Print the Research Worksheet ....................................................................................................... 30

Save and Exit Excel ........................................................................................................................ 30

Session 5 Extension Activity: Explore Pie and Line Graphs .............................................................. 31

Session 6 Write a Report

Session 6 Write a Report ...................................................................................................................... 33

Assignment 12 Report Solution to the Problem ................................................................................ 34

Open the Report Template in Word and Create a Copy ......................................................... 34

Add a Report Title ........................................................................................................................... 34

Add Student Name ........................................................................................................................ 34

Describe the Problem .................................................................................................................... 35

Explain Color Survey Results .......................................................................................................... 35

Explain Research Results ................................................................................................................ 35

What Is the Solution? Defend Your Plan ...................................................................................... 35

Copy Excel Graphs into the Report ............................................................................................. 36

Adjust Text Wrap ............................................................................................................................. 37



Contents 

Copyright © TechnoKids Inc. TechnoCandy | Microsoft 365 

Make the Report Look Great ........................................................................................................ 37

Save and Exit Word and Excel ...................................................................................................... 37

Assignment 13 Submit the Report ...................................................................................................... 38

Report Checklist.............................................................................................................................. 38

Print the Report ............................................................................................................................... 38

Save and Exit Word ........................................................................................................................ 38

Session 6 Review: Spreadsheet Quiz ................................................................................................. 39

Session 6 Extension Activity: Draw Packaging in PowerPoint ......................................................... 41

Appendices

Appendices .......................................................................................................................................... 43

Appendix A: Assessment Tools ........................................................................................................... 44

TechnoCandy Skill Summary ......................................................................................................... 44

Report Marking Sheet .................................................................................................................... 46

Appendix B: Contact Information ..................................................................................................... 47



Introduction 

Introduction

This section provides valuable information about teaching TechnoCandy. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

TechnoCandy Overview 

TechnoCandy Course Outline 

Technology Integration Ideas 
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TechnoCandy Overview 

In this course, students develop a plan to boost candy sales. They investigate a 

problem by conducting a survey and researching candy packaging. A 

spreadsheet is used to organize, calculate, and graph data. Based on the 

evidence students recommend a solution in a written report. Extension activities 

challenge students to explore formulas, learn advanced graphing techniques, 

or design a candy package. 

 

➢ In Session 1, students are introduced to Microsoft Excel and spreadsheet 

terminology. To learn about the program, students play Excel Bingo. This game 

has students identify cell references, navigate in a worksheet, enter data, fill cells 

with color, and select multiple cells. It is a fun way to learn essential spreadsheet 

skills. 

➢ In Session 2, students are given a problem to solve. A candy company is losing 

sales. Their number one candy is no longer number one. A study of the problem 

shows that children like the taste of the candy, but they say it is boring to eat 

because the colors are not fun. Students conduct a survey to learn more about 

what colors kids like. The survey results are entered into a Microsoft Excel 

spreadsheet. The data will be analyzed in upcoming sessions. 

➢ In Session 3, students produce a graph of their survey results. They make a bar 

graph. The color of the bars, chart area, and titles are then formatted to look 

attractive. Upon completion, students print the worksheet so that they have a 

complete record of their survey results. They will use this information in upcoming 

sessions to develop a plan to make the candy number one again. An optional 

activity, explains how to copy the survey worksheet and transform the data into 

different graphs to determine the most suitable type. 

➢ In Session 4, students continue gathering information for the candy company by 

studying packaging. Students estimate the number of colored candies contained 

in the average package of a chosen candy and record their predictions in a 

spreadsheet. Students then count and record the actual data. Using the sorting 

feature of Microsoft Excel, data is displayed in different views. Furthering their 

spreadsheet skills, students customize text within cells and add an image to 

create a professional looking document. 

➢ In Session 5, students make a comparison chart of the candy packaging research 

results. Using the skills learned in previous sessions, they make a bar graph. Once it 

is finished, they format the bar color, background, and labels so it looks great. 

Students then study the graph and summarize the results. An optional extension 

activity explores practical applications for a pie and line graph. 

➢ In Session 6, students develop a plan to make the candy number one again. They 

explain their idea in a report. The document summarizes the research findings 

and outlines a solution to the problem. If time permits an optional extension 

activity has students create a new package design for candy. It should attract 

customers' attention causing them to grab it off the store shelf. 
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TechnoCandy Course Outline 

Purpose: Use spreadsheets to organize, 

calculate, and graph data. Apply reasoning to 

solve problems and explain decisions in a report. 

Preparation: 

• Install Microsoft Office 365

• Prepare Bingo tags and print scoresheet.

• Share Candy folder with students

• Download Flashcards and Tool Summary from

TechnoHub (optional)

Objectives: (see Appendix A: Skill Summary) 

• connect mathematics to everyday life

• investigate a problem using spreadsheets

• collect data using a survey

• organize information into a table

• calculate data using formulas

• graph data and interpret results

• predict an outcome using logical reasoning

• conduct an experiment to test predictions

• classify and sort data

• develop a plan based on the evidence

• justify solutions in a written report

• find enjoyment in mathematics

Materials: 

• Assessment: Report Checklist, Spreadsheet Quiz

Report Marking Sheet, Skill Summary,

• Candy folder

o Sample Spreadsheet and Report

o Package Template

• Candy Packages (see Notes)*

• Bingo Resources

• Parent Letters and Certificate

• Flashcards and Tool Summary (optional)

Summary of Activities: 

• Understand the practical application of spreadsheets. Set a goal for learning.

• Explore Excel to understand spreadsheet terminology and acquire basic skills.

• Play Spreadsheet Bingo to practice identifying cell references and basic formatting skills.

• Develop an understanding of the problem. Formulate a plan to collect information.

• Conduct a survey about color preferences.

• Organize survey results in a spreadsheet. Format the data to make it easy to read.

• Calculate data using the Sum function.

• Graph survey data. Interpret the results.

• Investigate candy packaging. Record predictions and actual amounts of colored candies.

• Organize research results in a new sheet. Calculate totals using the Sum function.

• Sort data. Create a comparison graph. Analyze research findings.

• Recommend a solution to the problem based on the evidence. Use graphs to support reasoning.

• Complete a checklist. Submit report.

Extension Activities: 

• Have Fun with Cell References: Foster creativity and an enjoyment of a spreadsheet program.

• Experiment with Sum: Compare various calculations methods of summing data.

• Explore Chart Types: Compare line, pie, and bar graphs.

• Explore Pie and Line Graphs: Make different types of graphs.

• Draw Packaging in PowerPoint: Design a candy package using shapes, text, and images.

Assessment: 

• Self-Evaluation Checklists (Report Checklist – Assignment 13)

• Teacher Evaluation (Spreadsheet Quiz, Report Marking Sheet, TechnoCandy Skill Summary)

Notes: 

• This course focuses on developing basic spreadsheet skills. It is designed for beginners.

• Students need packages of multicolored candy to complete Assignment 9. Candy packages may

be purchased for individual students, pairs, or small groups. If candy is unsuitable, prepare

'packages' by placing a variety of colored objects into a bag and writing the total amount of

'candies' on the outside of the container.

• The report is written using a template to help students organize their ideas and accommodate

children with emerging keyboarding skills.

https://technohub.technokids.com/
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Technology Integration Ideas 

Have your students learn through problem-solving. The activities in TechnoCandy connect 

mathematics to a real-world situation that is simplified to make it understandable to children. 

Students are challenged to develop a solution that will increase candy sales. This course can be 

used to develop critical thinking, teach inquiry and analytic research methods, and build 

problem solving strategies. There are several ways to integrate TechnoCandy into curriculum: 

• Mathematics Problem Solving Unit

Make mathematics and spreadsheets enjoyable. Engage your students in a business

problem that they would like to solve. The activities in TechnoCandy use a problem-

solving model. Students gain an understanding of the problem, investigate the issue,

analyze the findings, and recommend a solution based on the evidence.

• Mathematics Graphing Unit

Teach graphing techniques in a meaningful way. TechnoCandy includes activities for

displaying data in a single and double bar graph. By interpreting the graphs students

make decisions based on real world data that they collected.

• Spreadsheet Unit

TechnoCandy can be included as part of a computer course or class. Students learn

basic skills such as how to manage sheets, format cells, calculate data, and graph cell

ranges. Extension activities make learning spreadsheets fun by playing Bingo and

drawing spreadsheet pictures. For older students, there are activities to develop

advanced graphing skills and a deeper understanding of addition formulas.

• Entrepreneurship Unit

Incorporate TechnoCandy as part of a business studies, finance, or entrepreneurship

course. The scenario allows students to investigate practical solutions to an everyday

problem that many business owners must overcome.

• Integrated Technology Unit

Develop computer, mathematics, language, and visual arts skills. Use Excel to analyze

data, Word to report findings, and PowerPoint to design a candy package.

Understand the Big Picture 

Not sure where to integrate TechnoCandy? View samples to gain a better understanding of the 

course. The Spreadsheet sample is a completed spreadsheet of survey results and candy 

package research. The Report sample describes a solution. 



   

 

 

Session 1 About Microsoft Excel 

 

Session 1 
About Microsoft Excel 

In this session, students are introduced to Microsoft Excel and spreadsheet 

terminology. To learn about the program, students play Excel Bingo. This game 

has students identify cell references, navigate in a worksheet, enter data, fill 

cells with color, and select multiple cells. It is a fun way to learn essential 

spreadsheet skills. 

Assignment 1: Spreadsheets and You 

Assignment 2: Explore Spreadsheets 

Assignment 3: Play Spreadsheet Bingo 

 

Session 1 Extension Activity: Have Fun with Cell References 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Your teacher needs to print 

the Bingo tags, cut them out, 

and put them in a container. 

Assignment 3 Play Spreadsheet Bingo 

Practice your spreadsheet skills with a game of digital Bingo! 

 

Your teacher needs to print the Bingo document BEFORE you play.  

It has the Bingo score sheet and tags you need for the game. 

 

 

What is Spreadsheet Bingo?  

 

Spreadsheet Bingo is a game where the goal is to be the first person to fill four horizontal, vertical, 

or diagonal, cells with color.  

 

How to Play 

 

Spreadsheet Bingo is played with an electronic game card.  

On the game card are the numbers 1, 2, or 3.  

 

 

A caller picks out a Bingo tag. On the tag is a cell name with a number.  

The caller reads what is on the tag.  

 

 
 

Find the cell. If it has the number called, you can fill that cell with color using Fill Color.  

 

 
 

The first person to fill four cells in a row with color, is the winner. 
 

   

Diagonal Vertical Horizontal 

  

In cell B2, the number 1. 

The BINGO 

document is in the 

TechnoCandy 

Resource folder. 

The caller uses the score 

sheet to track the numbers 

that have been called. 
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Make a Spreadsheet Bingo Card 

 

Get ready to play.  

Follow the instructions to make your own bingo card. 

 

Open Excel and Rename the Workbook 

 Open Excel.  

Click Blank workbook.  

 Click Save  on the Quick Access Toolbar. 

 Go to the place where you store your files. 

In the File name box, type Bingo.  

 

 Click Save. 

 

Make the Bingo Card 

 Fill cells from A1 to D4 with the number 1, 2, or 3. 

o Select A1. Type the number 1, 2, or 3. 

o Press TAB to select B1. Type 1, 2, or 3. 

o Press TAB to select C1. Type 1, 2, or 3. 

o Press TAB to select D1. Type 1, 2, or 3. 

o Select cell A2. Type 1, 2, or 3. 

Use your skills to complete the card. It should look something like this: 

 

 

Play Spreadsheet Bingo 

 

Now play the game. Your teacher is the caller. When he or she calls out a cell name and 

number look at your bingo card. Do you have the same number in the cell?  

 

If you do, fill it in with color using Fill Color.  

 

When you have four colored cells in a row, ( , , , ) say "Bingo!" 

You just may be the winner! 

 
Save and Exit Excel 

You need to make 

your bingo card. 

To play a new game, select the cells. Click 

the Fill Color   arrow and pick No Fill.  



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



   

 

 

Session 2 Conduct a Color Survey 

 

Session 2 
Conduct a Color Survey 

In this session, students are given a problem to solve. A candy company is 

losing sales. Their number one candy is no longer number one. A study of the 

problem shows that children like the taste of the candy, but they say it is 

boring to eat because the colors are not fun. Students conduct a survey to 

learn more about what colors kids like. The survey results are entered into a 

Microsoft Excel spreadsheet. The data will be analyzed in upcoming sessions. 

Assignment 4: Understand the Problem 

Assignment 5: Conduct a Survey 

Assignment 6: Record Survey Results in a Spreadsheet 

Assignment 7: Calculate Survey Data 

 

Session 2 Extension Activity: Experiment with Sum 
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Assignment 6 Record Survey Results in a Spreadsheet 

You have surveyed people to find the candy colors they like and the colors they do not like. 

 

Put the survey results into a spreadsheet.  

This will make it easier to study the information. 

 

 
 

Open Excel 

 Open Excel.  

Click Blank workbook.  

 

 

Add the Sheet Title 

 In cell A1, type Color Survey. 

Press ENTER. 

 

 

Organize Survey Results 

 In cell A3 type Colors. 

 In cell B3 type Votes. 

 In cell A4 type a color name from the Assignment 5 survey. Press ENTER. 

 In cell A5, type the next color. Repeat until all the colors are listed. 

 Select cell B4, type the number of votes for the color in A4. Press ENTER. 

 Continue to add survey data. 
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Merge Cells for the Survey Title 

 Select A1, hold down the SHIFT key, and click E1.  

 Click Merge & Center.  

 
 

Format the Appearance of the Title 

 Select the title. Make the title easy to read: 

o Click the Font arrow. Pick an option.  

o Click the Font Size arrow. Pick a number.  

o Apply a style. Click Bold , Italic , or Underline  . 

 

Change the Font Color and Fill a Cell 

 Select the cell with the title. 

 Click the Fill Color  arrow. 

Pick a color from the palette. 

 

 Click the Font Color  arrow. 

Pick a color from the palette. 

 

Align the Title 

 Select the title cell. 

 Explore the horizontal alignment options: 

Pick Align Left , Center , or Align Right  . 

 

Adjust Row Height and Align Vertically 

 Position the mouse pointer between row headings 1 and 2. Drag down.  

 Explore the vertical alignment options: 

Pick Top Align , Middle Align , or Bottom Align  .  

Merging cells joins them 

together as one big cell. 

This makes a title look great. 

Color can be used 

to make titles and 

headings stand out. 



  Session 2 

Copyright © TechnoKids Inc. 15 TechnoCandy | Microsoft 365 

Outline the Table with Borders 

 Select the survey table. For example, cells A3:B12. 

 Click the Borders  arrow.  

Pick All Borders.  

 

 

 

Resize Column Width 

 Place the mouse pointer between column headings A and B. 

 Click and drag or double click to change the size. 

 
 

Use Skills to Format the Survey Data 

 

 
 

 
 

Save a Workbook and Exit Excel 

 Click Save  on the Quick Access Toolbar. 

 Go to the place where you store your files. 

 In the File name box, type Candy Company Name.  

  Click Save. 

 Click Close.  

Make the information easy to read. 

Spreadsheet Suggestions: 
 

✓ Fill the headings with color.  

✓ Align the votes to the center.  

✓ Apply bold to the headings.  

You picked the name 

in Assignment 4. 
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Session 3 
Graph the Color Survey 

In this session, students produce a graph of their survey results. They make a 

bar graph. The color of the bars, chart area, and titles are then formatted to 

look attractive. Upon completion, students print the worksheet so that they 

have a complete record of their survey results. They will use this information in 

upcoming sessions to develop a plan to make the candy number one again. 

An optional activity, explains how to copy the survey worksheet and transform 

the data into different graphs to determine the most suitable type. 

Assignment 8: Graph the Survey Results 

 

Session 3 Extension Activity: Explore Chart Types 
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Assignment 8 Graph the Survey Results 

What color candy do people like the most? Find out! 

 

Make a graph of the candy color survey results. 

 

A graph is a picture of information.  

 

A column graph uses bars to show numbers. The taller the bar, the more people like the color. 

The shorter the bar, the less people like the color. 

 

Open Candy Workbook in Excel 

 

Create a Column Chart 

 Select cell A4. It has the first color name. 

 Hold the SHIFT key. Select the cell in column B with the last vote (above the formula). 

 
 

 Click the Insert tab and choose Column  from the Charts group. 

 Choose Clustered Column from the gallery.  

 
 

 

Move and Resize the Graph 

 Click and drag  the graph BESIDE the Survey Results table. 

 Drag a sizing handle  to change the graph size.  

  

Select the cells 

to include in 

the graph. 
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Edit the Graph Title 

 Click Chart Title to select it.  

 Triple click to select all the text in the chart title. 

 Type Colors People Like or Color Survey.  

 

Apply a Chart Style 

 Click the Chart Design tab. 

 Click the Chart Styles More arrow.  

Pick a style you like. 

 
 

Fill a Bar with Color 

 Double click on a bar. Right click on it. 

 Click the Fill  arrow. Pick a color from the palette that matches the item. 

 Use your skills to make each bar the color of the candy 

 
 

Fill the Plot Area 

 Double click the graph background. 

Click the Fill  arrow. Pick a color from the palette. 

 Click the Fill  arrow again.  

Pick Gradient. Pick a style. 

 

  

Click More Fill Colors 

to see more choices. 



  Session 3 

Copyright © TechnoKids Inc. 21 TechnoCandy | Office 365 

What Do Your Survey Results Mean? 

 

Create an area to add a summary of what your results mean. 

 Below the Survey Results table select a group of cells. 

 Click Merge & Center.  

 Explain the survey results: 

o What colors do people like the most? 

o What colors do people like the least? 

 

 
 

Adjust Text Wrap and Format the Text 

 Select the merged cell. Click Wrap Text.  

 Set the alignment to the top  and to the left . 

 Apply your skills to set the font , size , fill , and border  . 

 

Print the Worksheet 

 Type your Name into a cell. 

 From the File tab, click Print. 

Select print options: 

o Click Portrait Orientation. Pick Landscape Orientation. 

o Click No Scaling. Pick Fit Sheet on One Page. 

 

 Click Print.  

 

Save and Exit Excel 

Merge to make one big 

cell. You will use it to 

describe survey results. 

Adjust print settings to 

place all the information 

on one sheet of paper. 
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Session 6 
Write a Report 

In this session, students develop a plan to make the candy number one again. 

They explain their idea in a report. The document summarizes the research 

findings and outlines a solution to the problem. If time permits an optional 

extension activity has students create a new package design for candy. It 

should attract customers' attention causing them to grab it off the store shelf. 

Assignment 12: Report Solution to the Problem 

Assignment 13: Submit the Report 

 

Session 6 Review: Spreadsheet Quiz 

Session 6 Extension Activity: Draw Packaging in PowerPoint 
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Assignment 12 Report Solution to the Problem 

You have been working to solve the candy company’s problem. Their number one 

candy has been losing sales. People like the taste, but they say the candy is not fun 

to eat because the colors are boring. 

 

You have been researching candy colors. You have found out what colors people 

like the most and least. You also know what colors are in the candy package. It is time to use this 

information to form a plan so that the candy will be number one again. 

 

You will explain your solution in a report. 

 

Make a Plan to Make the Candy Number One 

1. What changes to the color of candy do you need to make?  

2. What colors should have more candies in the package?  

3. What colors should have less candies in the package?  

4. When coming up with your plan you cannot add candies to the package.  

The total number of candies must stay the same. 

 

 

Open the Report Template in Word and Create a Copy 

 Ask your teacher how to open the Report template. It is in the Candy folder. 

 Click Save  on the Quick Access Toolbar. 

 Go to the place where you store your files. 

In the File name box, type Candy Name Report.  

 Click Save. 

 

 

Add a Report Title 

 Triple click on Report Name. 

 Type a Report Name such as Candy Report, Action Plan, or Sales Solution. 

 

 

Add Student Name 

 Click in front of Student Name. 

Drag the mouse pointer to select the words. 

 Type Student Name. 
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Describe the Problem 

 Describe the problem using information from Assignment 4. 

o Replace Company Name. 

o Replace Candy Name. 

 

 
 

Explain Color Survey Results 

 Look at the printout from Assignment 8. Replace words in red to explain survey results.  

o What color do people like the most? 

o What color do people like the least? 

 

 
 

Explain Research Results 

 Look at the printout from Assignment 11. Replace words in red to explain research results.  

o What color of candy is in the package the most? 

o What color of candy is in the package the least? 

o What is interesting about your research results? 

 

 
 

What Is the Solution? Defend Your Plan 
 

Adding more candies to the package would cost the company money. Make a plan that keeps 

the number of candies in the package the same. 

 Explain the changes that need to be made to the candies:  

o What color(s) should have more candies in the package?  

o What color(s) should have less candies in the package?  

o Explain why this is a solution that will improve sales. 

  

Yum Yum Candies Report 
 
By Sally Solver 
 

Problem 
 

Yum Yum Candies is losing sales. The number one candy Jelly Bursts are no longer number 

one. People say they like the taste, but they are boring to eat because the colors are not fun. 

Color Survey Results 
 

I did a survey to find out the colors of candy people like to eat. I found that people like red candy 
the most. I found that people like green candy the least. 

Candy Package Research Results 
 

I counted the number of candy in each package. I found that most were purple candies. I found 
that there were only a few orange candies. I was surprised that there were grey candies in the 
package. I found it interesting that there were not more red candies. 

Solution 
 

To increase sales, I think that the company should increase the number of red candies in the 
package and decrease the number of green candies in the package. This will work because 
people like red the most. 

Edit the text so 

the sentences 

make sense. 

Replace the red 

words with 

survey results. 

What surprised you 

about the results? 

Why is your plan 

a good idea? 
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Copy Excel Graphs into the Report 

 

The graphs that you created in Excel will help to explain your action plan. The column 

graph about the survey results shows the colors that children like. The comparison 

graph shows the candy packaging research results. Follow the instructions to copy 

the graphs from Excel into Word. 

 

Copy the Survey Results Graph 

 Open the Candy Company Name workbook in Excel. 

 View Sheet1 with the survey results. 

 Select the graph. From the Home tab click Copy.  

 

Paste the Survey Results Graph into the Candy Report 

 Display your report. To do this you can:  

o Click the Minimize button  at the top of the Excel Window.  

o Click the Word icon  in the taskbar.  

 Position the cursor below the Color Survey Results heading and information. 

 On the Home tab, click the Paste arrow.  

 Click Picture.  

 

 Use your skills to resize the graph.  

 
 
 

Copy and then Paste the Comparison Graph 

 Click the Excel icon in the taskbar to display the candy workbook.  

 Click the Research sheet tab at the bottom of the worksheet. 

 

 Use your skills to copy  and then paste  the graph into the report as a picture.  

  

Color Survey Results 
 

I did a survey to find out the colors of candy people like to eat. I found that people like red candy 
the most. I found that people like green candy the least. 

 

You may want to 

center  the graph.  

Turn the graph into a 

picture. This will make it 

easy for you to resize. 
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Adjust Text Wrap 

 Select the graph. 

 Click Layout Options.  

Pick Square.  

 

 Drag  the graph to wrap text around it.  

 

 

Make the Report Look Great 

 Use your skills to make the report title and headings look great! The words need to stand 

out on the page and be easy to read. Fit the report onto one page. 

o Change the font.  

o Set the size of the letters.  

o Darken the letters.  

o Slant the letters to the right.  

o Place a line below the letters.  

o Change the color of the letters.  

 

 
 

Save and Exit Word and Excel 

 

To see the whole page, click the 

View tab. Click One Page.   

Text wrap changes how 

words go around a picture. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 6 Review: Spreadsheet Quiz 

Match the tool to its function. 

 

1. B  A. calculate data using a function 

     

2. A  B. add a bold style to text 

     

3. F  C. add borderlines 

     

4. H  D. insert a chart or graph 

     

5. G  E. wrap the text  

     

6. D  F. change the color of text 

     

7. C  G. merge cells and center text 

     

8. E  H. fill a cell or object with color 

/8 
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9. Label the worksheet.  Row 3 E6 Column B 

 

 

 1.  Column B  

 2.  Row 3  

 3.  E6  

 
/3 

 

10. Match the spreadsheet term to its meaning. 

 
a. a letter name for a column column heading 

 
worksheet 

 
b. grid made of columns and rows worksheet 

 
cell 

 
c. a number name for a row row heading 

 
column heading 

 
d. a picture of information graph 

 
row heading 

 
e. a calculation performed on data formula 

 
merge 

 
f. combine together multiple cells merge 

 
formula 

 
g. a box in a worksheet, such as C3 cell 

 
graph 

/7 

 

11. List two ways people can use a spreadsheet. 

 track grades, calculate budget, schedule events, organize research data 

 estimate job costs, create an invoice or quote, collect survey results 

/2 

 

 

TOTAL          /20 
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Session 6 Extension Activity: Draw Packaging in PowerPoint  

Create candy packaging that will attract attention using a PowerPoint template. 

 

       
 

1. Open the package template in PowerPoint.  

2. Save the file to your folder. 

 a. Click Save  on the Quick Access Toolbar. Click Save As. 

 b. Go to the place where you store your files. 

 c. Click Save. 

 

3. Add the Candy Name: 

 

 a. From the Insert tab, click Text Box.  

 b. Click and drag to draw a box. Type Candy Name. 

 c. Set the font  , size  , style    , color  , and alignment.  

 d. Resize , move , and rotate  the text box. 

 

4. Format the text box using the Shape Format tab: 

  
 

Shape Styles 
 

Shape Fill 
 

Shape Outline 
 

Shape Effects  

  

    

 

 

5. Draw a shape for product details: 

 a. Click the Insert tab. Click Shapes.  Pick a shape. 

  

 

 b. Click and drag to draw a shape. 
   

 c. Use your skills       to make the shape look great.  
   

 d. Resize , move , rotate , or bend  the shape (not all shapes can be bent). 
   

 e. Click inside the shape. Type product information such as New or Sweet. 
   

 f. Set the font  , size  , style    , color  , and alignment.  
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6. Add a slogan with WordArt: 

 a. From the Insert tab, click WordArt.  Pick a style from the gallery. 

 

 b. Type a slogan. 

 c.  Click the Shape Format tab. Explore the options on the WordArt Styles group: 

   WordArt Styles – Apply a style to the text. 

   Text Fill – Fill the letters with a color, picture, gradient, or texture. 

   Text Outline – Set the line color, width, or dash. 

   Text Effects – Apply an effect such as shadow, glow, bevel, or transform. 

 d. Resize , move , and rotate  the WordArt. 

 

7. Insert an image of the candy: 

 a. Click the Insert tab. Click Pictures.  Choose Online Pictures.  

 b. Type candy in the search box. Press ENTER. 

 c. Select a picture you like and click Insert. 

 

 d. Resize , move , and rotate  the image. 

 e. Click the Picture Format tab. Explore the options on the Picture Styles group: 

   Picture Styles – Apply a style to the picture. 

   Picture Border – Set the line color, width, or dash. 

   Picture Effects – Apply an effect such as shadow, glow, bevel, or 3-D rotation. 

 

8. Adjust object order: 

 a. Move the candy picture on top of the WordArt.  

 b. On the Picture Format tab, click the Send Backward  arrow. Pick an option. 
 

9. Apply skills to complete the candy package. 

 

 
 

Candy Package Tips: 

✓ Fill WordArt with a candy picture to create a unique design. 

✓ Crop a picture into a shape.  

✓ Click Undo to remove an action.  

Drag the scroll box to 

view more pictures. 



 

 

 

Appendices 

 

Appendices 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

TechnoCandy Skill Summary 

Report Marking Sheet 

Appendix B: Contact Information 
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Report Marking Sheet 

Candy Survey Results  

The report describes the color of candy people like the most and least.  

A graph shows survey results. /3 

Candy Package Research Results  

The research results describe the colors of candy in the package.  

Insights about the research findings are shared.  

A graph shows research results. /4 

Solution  

The solution is clearly explained.  

The plan does not change the amount of candies in the package.  

The plan includes more colored candies that people like and less of ones they do not.  

A logical reason is provided for why the plan will be a success. /4 

Report Design  

The title and headings stand out on the page.  

The words are easy to read.  

The graphs are placed neatly on the page. /3 

Spelling and Grammar  

The words are spelled correctly.  

Sentences use the proper punctuation. /1 

TOTAL: /15 

 

 
 

 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Yum Yum Candies Report 

 

By Sally Solver 

 

Problem 

 

Yum Yum Candies is losing sales. The number one candy Jelly Bursts is no longer number 

one. People say they like the taste, but it is boring to eat because the colors are not fun. 

 

 

Color Survey Results 

 

I did a survey to find out the colors of candy children like to eat. I 

found that children like red the most. I found that children like 

green the least. 

 

 

Candy Package Research Results 

 

I counted the number of candy in each package. I found that most of the candies were purple. I 

found that there were only a few orange candies. I was surprised that there were grey candies 

in the package. I found it interesting that there were not more red candies.  

 

 

Solution 

 

To increase sales, I think that the company should increase the number of red candies in the 

package and decrease the number of green candies in the package. This will work because 

people like red the most. 

 



Colors Votes

Blue 5

Red 8

Orange 3

Yellow 4

Green 1

Purple 4

Black 7

Brown 3

Pink 2

TOTAL 37

Color Survey

37 people  were surveyed. The most popular color was red and the least popular was green. 
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Colors Predict Actual

Orange 5 3

Grey 0 4

Brown 15 5

Black 12 7

Red 20 9

Green 15 10

Yellow 5 11

Blue 9 12

Pink 9 16

Purple 10 23

TOTAL 100 100

Candy Research

I predicted that there would be more red candies than any other. I discovered that there were more purple candies. I thought 

there would be no grey candies, but orange was the lowest number. I was surprised that there were not more red candies.
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